CONTENTS

- Field of Application
- Installation on Windows
- Installation on Mac
- Activation
- License Comparison
- Workspace
- Using the Program
- Toolbar
- Parameters
- Vignette
- Preferences
- Batch Processing
- Print Image
- Removing Large Objects
- Restoration of an Old Family Photo
- Lioness in a Cage: Removing Rods
- Daguerreotype Portrait of 1893
- AKVIS Programs
IMAGE RESTORATION SOFTWARE

**AKVIS Retoucher** is an efficient program for **photo restoration** and **photo retouching**.

**AKVIS Retoucher** not only **removes dust, scratches, stains** and other defects that appear on damaged photos but is also able to **reconstruct missing parts** of a photo using the information of the surrounding areas.

The work is done automatically; you only have to indicate areas to be restored, push the **Run** button, and here you are - the surface becomes smooth and imperfections disappear.

It looks like magic when you observe the scratches vanishing before your very eyes!

**AKVIS Retoucher** is also a handy tool for improving photo composition. It is possible to **remove date stamps**, small **irrelevant details** (wires, refuse bins, etc) and even bigger **objects** (i.e. people who fell into the shot by accident, cars in the background).
If you need to increase the canvas size (from one side or proportionally) to bring the main object into focus, i.e. to center it, Retoucher will help you to extend image patterns to the blank areas of the canvas.
Polygraphists will find Retoucher useful in doing the prepress processing job. They often have the problem of extending the borders of a layout that does not have space for cropping. **AKVIS Retoucher** saves much time by doing this quickly and efficiently!

Use **AKVIS Retoucher** for the following purposes:

- Restore old and damaged photos from your family archive by removing scratches, stains and other defects;
- Improve the composition of your photos by removing the date stamp, distracting details (wires, refuse bins, etc) and by extending the photo canvas (increase the image canvas and the plug-in will recreate the image patterns in the blank areas);
- Reconstruct missing parts of the photo (to restore a torn photo, in polygraphy to extend the borders of a layout that does not have space for cropping).
- Remove larger and complex objects (people, cars, buildings).

**AKVIS Retoucher** is your reliable tool for increasing productivity!

**AKVIS Retoucher** is available as an independent program (standalone) and as a plugin to a photo editor. The functionality of the program depends on the license type.

The plugin version is compatible with Adobe Photoshop, Photoshop Elements, Corel Paint Shop Pro, etc. Check the compatibility page for more details.
Attention! You must have administrator rights to install the program on your computer.

Before installing the AKVIS Plugin, please make sure that the photo editor where you want to install the plugin, is closed.

Follow the instructions to install **AKVIS Retoucher** in Windows.

- Start the setup **exe** file.
- Select your language and press the **OK** button to launch the installation process.
- To continue the installation process you have to read and accept the **License Agreement**.

  Activate the check box "**I accept the terms in the license agreement**", and press **Next**.

- To install the **Plugin** you should select your photo editor(s) from the list.

  **Hint:**
  If your photo editor is not in the list, activate the component **Custom Plugins Directory** and choose the folder where you keep all plugins and filters, for example, **C: \ My Plugins**. In this case you should set this folder as the plugins folder in the settings of your photo editor.

  Or you can copy the **8bf** file into the Plug-ins folder of your image editor.

To install the **Standalone version**, make sure that the check-box **Standalone** is activated.
To create a shortcut for the program on desktop, activate the component **Shortcut on Desktop**.

Press the button **Next**.
• Press the button **Install**.

• The installation is in progress.
The installation is completed.

You can subscribe to the AKVIS Newsletter to be informed about updates and events.

Press **Finish** to exit Setup.

After installation of the standalone version of Retoucher, you will see a new line in the **Start** menu: **AKVIS - Retoucher** and a shortcut on desktop, if during installation the component **Shortcut on Desktop** was enabled.
After installation of the Retoucher plugin you will see a new item in the Filter/Effects menu of your photo editor. For example in Photoshop: **Filter -> AKVIS -> Retoucher.** Please use this command to launch the plugin in the editor.
Attention! You must have administrator rights to install the program on your computer.

Before installing the AKVIS Plugin, please make sure that the photo editor where you want to install the plugin, is closed.

Follow the instructions to install **AKVIS Retoucher** in a Mac computer:

- Open the virtual disk `dmg`:
  - `akvis-retoucher-app.dmg` to install the **Standalone** version
  - `akvis-retoucher-plugin.dmg` to install the **Plugin** to your image editor (Photoshop or Photoshop Elements).

- Read the **License Agreement** and press **Agree**, if you agree with the conditions.

- **Finder** will open with AKVIS Retoucher application or AKVIS Retoucher PlugIn inside.

- To install the **Standalone** version just drag the AKVIS Retoucher application into the folder **Applications** (or any other place you like).

- To install the **Plugin** drag the entire AKVIS Retoucher PlugIn folder into the **Plug-Ins** folder of your graphic editor.

For example:

- **Photoshop CC 2018**, copy the plugin into **Applications/Adobe Photoshop CC 2018/Plug-Ins**;
- **Photoshop CC 2017**, copy it into **Applications/Adobe Photoshop CC 2017/Plug-Ins**;
- **Photoshop CC 2015.5**, copy it into **Library/Application Support/Adobe/Plug-Ins/CC**;
- **Photoshop CC 2015**, copy it into **Applications/Adobe Photoshop CC 2015/Plug-ins**;
- **Photoshop CS6**, copy it into **Applications/Adobe Photoshop CS6/Plug-ins**.

```
After installation of the plugin, you will see a new item in the Filter menu of your photo editor. In Photoshop select in menu: **Filter -> AKVIS -> Retoucher.**

Run the standalone app by double-clicking on its icon in Finder.
HOW TO ACTIVATE AKVIS SOFTWARE

Attention! During the activation process your computer must be connected to Internet.
If it is not possible, we offer you an alternative way (see below for Offline Activation).

Download AKVIS Retoucher and install the program. Read the Installation Instruction here.
When you run the unregistered version, a splash window will appear displaying general information about the version and the number of days left in your trial period.
You can also open the About the Program window by pressing the button in the program's Control Panel.

Click on TRY IT to evaluate the software. A new window will appear with variants of licenses to test.
You do not need to register the trial version to try all features of the software. Just use the program during the evaluation time (10 days after the 1st start).
During the test period you can try all options and choose the license you like. Select one of the offered functionality types: Home (Plugin or Standalone), Home Deluxe, or Business. Your choice of license will affect which features will be available in the program. Consult the comparison table for more details about license types and versions of the software.
If the trial period has expired, the TRY IT button is disabled.

Click on BUY NOW to choose a license to order.
When the payment is effected, your serial number for the program will be sent to you within minutes.

Click on ACTIVATE to start the activation process.
Enter your name (the program will be registered to this name).

Enter your serial number (your license key).

Choose the method of activation — either direct connection to the activation server or by e-mail.

**Direct connection:**

We recommend activating the program using direct connection, as it is the easiest way.

At this step your computer must be connected to Internet.

Press **ACTIVATE**.

Your registration is completed!

**Request by e-mail:**

In case you have chosen activation by e-mail, a message with all necessary information will be created by the program.

**NOTE:** You can also use this method for **Offline Activation**:

If your computer is not connected to Internet, transfer the activation message to a computer connected to Internet, for example, with a USB stick. Send us this information to: activate@akvis.com.

**Please do not send the screenshot!** Just copy the text and save it.

We need your serial number for the software, your name, and HardwareID (HWID) of your computer.

We will generate your license file (**Retoucher.lic**) using this information and will send it to your e-mail address.

Save the **.lic** file (do not open it!) to your computer where you want to register the software, in the **AKVIS** folder in Users' Shared (Public) Documents:

- **Windows Vista/7/8/10:**
  Users\Public\Documents\AKVIS;

- **Windows XP:**
  Documents and Settings\All Users\Documents\AKVIS;

- **Mac:**
  Users/Shared/AKVIS.
Your registration is completed!

When the program is registered, **BUY NOW** turns to **UPGRADE** that lets you improve your license (for example, change **Home** to **Home Deluxe** or **Business**).
**IMAGE RESTORATION SOFTWARE**

**AKVIS Retoucher** is an efficient program for photo restoration and photo retouching.

The functionality of the program depends on the license type. During the evaluation period you can try all options and choose the license you like.

<table>
<thead>
<tr>
<th>License Comparison:</th>
<th>Home (Plugin)</th>
<th>Home (Standalone)</th>
<th>Home Deluxe (Plugin+Standalone)</th>
<th>Business (Plugin+Standalone)</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Purpose</strong></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>non-commercial use</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>commercial use</td>
<td>—</td>
<td>—</td>
<td>—</td>
<td>✓</td>
</tr>
<tr>
<td><strong>Edition</strong></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Plugin</td>
<td>✓</td>
<td>—</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Standalone</td>
<td>—</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td><strong>Features</strong></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Automatic Restoration</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Selection &amp; Retouching Tools</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Post-Processing Tools</td>
<td>—</td>
<td>—</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Vignette</td>
<td>—</td>
<td>—</td>
<td>—</td>
<td>—</td>
</tr>
<tr>
<td>Import/Export Files:</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>*.retouch (Selection)</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Batch Processing</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Share</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Print</td>
<td>—</td>
<td>✓</td>
<td>—</td>
<td>✓</td>
</tr>
<tr>
<td>Large Format Print</td>
<td>—</td>
<td>—</td>
<td>—</td>
<td>✓</td>
</tr>
<tr>
<td>EXIF, IPTC</td>
<td>—</td>
<td>—</td>
<td>—</td>
<td>—</td>
</tr>
<tr>
<td><strong>Color Space</strong></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>RGB</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>CMYK</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Lab</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Grayscale</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>8 / 16 bits</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>32 bits</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td><strong>Image Format</strong></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>TIFF</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>JPEG</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>BMP</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td></td>
<td>PNG</td>
<td>RAW</td>
<td>DNG</td>
<td>PSD</td>
</tr>
<tr>
<td>----------</td>
<td>-----</td>
<td>-----</td>
<td>-----</td>
<td>-----</td>
</tr>
<tr>
<td>Listed</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td></td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td></td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td></td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
</tbody>
</table>
**WORKSPACE**

**AKVIS Retoucher** is available as a standalone program as well as a plug-in for graphics editors.

- *Standalone* is an independent program; you can open it by clicking on the program's icon.

  To launch the standalone version, run the program directly:

  - On a Windows computer - select it from the **Start** menu or use the program's shortcut.
  - On a Mac computer - launch the app from the **Application** folder.

- *Plugin* is an add-on for a photo editor.

  To call the plugin, select it from filters of your image editing program.

The workspace view depends on which editing mode is chosen in the **Control Panel**: **Express** or **Advanced**.

In **Express** mode, the program's interface is extremely simplified, with a minimal set of tools designed to quickly achieve a satisfactory result.

In **Advanced** mode, all options and tools are available.
Most of the program's workspace is taken up by the **Image Window**, above which is the **Control Panel** with the following controls:

The button [open] opens the home page of **AKVIS Retoucher**.

The button [open] (only in the standalone version) opens the image which will be edited. The hot-keys are `Ctrl+O` on Windows, `⌘+O` on Mac.

Right mouse click on this button displays the list of recent files. You can change the number of recent documents in the program's **Preferences**.

The button [open] (only in the standalone version) saves the edited image to a file. The hot-keys are `Ctrl+S` on Windows, `⌘+S` on Mac.

The button [open] (only in the standalone version) is used to print an image. The hot-keys are `Ctrl+P` on Windows, `⌘+P` on Mac.

The button [open] lets posting pictures from the program to the social networks: Twitter, Flickr, Tumblr, Google+.

The button [open] loads selected areas that have been saved to a file (.retouch).

The button [open] saves selected areas to a separate file in the .retouch format.

The buttons [open] show/hide selected areas.

The button [open] opens the **Batch Processing** dialog to automatically process a series of images.

The button [open] cancels the last action. If it is pressed multiple times, it will cancel several previous actions. This can also be activated with the keyboard, by pressing `Ctrl+Z` on Windows, `⌘+Z` on Mac.

The button [open] restores an action cancelled by ❯. An action can also be restored with the keyboard, by pressing `Ctrl+Y` on Windows, `⌘+Y` on Mac.

The button [open] begins the restoration process. The hot-keys are `Ctrl+R` on Windows, `⌘+R` on Mac.

The button [open] (only in the plug-in) applies the processing result and then closes **AKVIS Retoucher**.

The button [open] shows information about the program.

The button [open] opens the program's help files. The hot-key is `F1`.
The button opens the Preferences dialog box.

To the left of the Image Window there is the Toolbar. Different tools will appear, depending on the workspace mode Express/Advanced chosen. The tools' parameters are shown in the Settings Panel or in a pop-up box after right-clicking in the image window.

Navigate and scale the image using the Navigator. In the Navigator you can see the reduced copy of the image. The frame shows the part of the image that is now visible in the Image Window; the areas outside the frame will be shaded. Drag the frame to make other parts of the image visible. To move the frame, bring the cursor inside the frame, press the left mouse button and, keeping it pressed, move the frame in the Navigator.

To scroll the image in the Image Window you can press the spacebar on the keyboard and drag the image with the left mouse button. Use the scroll wheel of the mouse to move the image up/down, by keeping the Ctrl on Windows, ⌘ on Mac key pressed – to the left/to the right, by keeping the Alt on Windows, Option on Mac key pressed – scale the image. Right-click on the scroll bar to activate the quick navigation menu.

Use the slider or the buttons + and - to scale the image in the Image Window. When you click on the + button or move the slider to the right, the image scale increases. When you click on the - button or move the slider to the left, the image scale reduces.

You can also change the image scale by entering a new coefficient into the scale field. The fall-down menu shows some frequently used coefficients.

You can use hot-keys to change the image scale + and Ctrl+ on Windows, ⌘+ on Mac to increase the image scale and - and Ctrl+ on Windows, ⌘+- on Mac to reduce the scale.

Under Navigator is the Settings Panel with parameters for the algorithm and tools.

Under the Settings Panel you can see Hints for the parameters and buttons when you hover over them with the cursor.
HOW IT WORKS

To retouch photos using **AKVIS Retoucher**, follow these steps:

**Step 1.** Open the image, which needs to be restored or edited, from which unnecessary details and defects need to be removed.

- If you work with the standalone version:

  Run the standalone program **AKVIS Retoucher**.

  To open an image in the program, you can double-click in the empty workspace of Retoucher, or drag the image into the workspace, or press the button on the Control Panel. The program supports **RAW**, **JPEG**, **PNG**, **BMP**, and **TIFF** file formats.

- If you work with the plugin:

  Run your photo editor. The Retoucher plugin is compatible with Adobe Photoshop, Adobe Photoshop Elements, Corel Paint Shop Pro, and many other image editors.

  Open an image in your photo editor by calling the command **File -> Open** or using the keyboard shortcut `Ctrl + O` on Windows, `⌘ + O` on Mac.

  Then call the **AKVIS Retoucher** plugin in the Filter/Effects menu of the photo editor:

  In **AliveColors**: Effects -> AKVIS -> Retoucher;  
  in **Adobe Photoshop**: AKVIS -> Retoucher;  
  in **Corel Paint Shop Pro**: Effects -> Plugins -> AKVIS -> Retoucher;  
  in **Corel Photo-Paint**: Effects -> AKVIS -> Retoucher.

**Step 2.** The first time the program starts it will be in **Express** mode, with a simplified interface and a minimal set of tools designed to quickly achieve a satisfactory result.

Experienced users can work in the advanced editing mode. Switch to this mode by clicking **Advanced** in the **Control Panel**: the interface's appearance will change, providing access to the full functionality of the program.
Step 3. Mark the areas of the image which need to be retouched. It might be a scratch, text, or a small object which needs to be removed. Selections made in the graphics editor are transferred to the plug-in.

**Attention!** Use the Crop tool before starting the retouching process.

You can use the following tools to make a selection: Selection Brush, Exclusion Tool, Eraser, Selection Bucket, and Magic Wand. The selected areas will be highlighted in red.
You can save your work on a selection to a file (in `.retouch` format) with the button. You can then load this selection at any time by pressing the button.

**Step 4.** When working in Advanced mode, selection areas can be processed further using the tools Linear Retouch and Patch.

More about using these tools can be learned from these examples.

**Step 5.** In the Settings Panel, select a photo retouching mode: All-Purpose Retouching or Small Defects. Adjust the parameters.

The All-Purpose Retouching mode can be used to process any type of defects but is particularly suitable for large and medium-sized imperfections.

The Small Defects mode is specially designed for enhanced removal of small imperfections like scratches, dust, specks, etc. The innovative algorithm allows more accurate and detailed image restoration.

If necessary, adjust the brightness and contrast of the image using the Color Correction settings.

Press to start reconstructing the image. The hot key for this operation is `Ctrl+R` (`⌘+R` on Mac).

If you are not satisfied with the result, you can make correct the selection areas or adjust the algorithm’s parameters in the Settings Panel and start processing the image again.

The result will immediately begin to appear after processing has started. If you are sure that the result will not turn out as you would like, you can interrupt processing by clicking on the Cancel button, which is located to the right of the progress bar, then make changes to the parameters and start processing again by pressing.

**Note:** In Advanced mode you can use Local Run to focus more clearly on individual selections in the image. Press to quickly access this tool. Processing begins after you click on an individual...
selected area. You can work step by step, selection by selection, fine-tuning the parameters to restore each selection more effectively. This is useful when you want to remove a large, complex object. If the processing result is not entirely successful, it is possible to undo the change with the buttons and make a correction (for example, remove unnecessary fragments, change the selection or the algorithm’s parameters, apply a patch, etc.)

**Step 6.** Those using the Home Deluxe and Business have the opportunity to perform post-processing with the tools **Clone Stamp**, **Chameleon Brush**, **History Brush**, and **Spot Remover**.

Also, for Home Deluxe and Business licenses, the **Vignette** effect is available.
Step 7. Share your work by clicking on ![Share](image.png). It opens the list of the services where you can publish the image: Twitter, Flickr, Tumblr, Google+.

In the standalone version, you can also print your image with ![Print](print.png).

Step 8. Save the resulting image.

- When using the standalone:

  Press the ![Save](save.png) button and in the **Save Image** dialog window, type a name for the file, select a format (TIFF, BMP, JPEG or PNG), and choose a folder in which to save the file.

- When using the plug-in:

  Press the ![Apply](apply.png) button to apply the result (in the plug-in only). The **AKVIS Retoucher** plug-in's window closes, and the image is returned to the graphic editor's window.

  Open the save file dialog **File -> Save As** in the graphics editor, type a file name, specify a file format and choose a folder, in which to save the file.
The **Toolbar** in **AKVIS Retoucher** contains groups of tools used to select defects and retouch images. The tools parameters can be adjusted in the **Settings Panel**, or in a pop up window which appears after right-clicking in the image.

You can quickly change the brush size with the `[` and `]` keys.

To draw a straight line, select a starting point by clicking the left mouse button, then, while holding down `Shift`, drag the cursor with the mouse to a new location on the image, click the left mouse button again and release `Shift`. If `Shift` is not released, a new line will be drawn to each point where the left mouse button is clicked.

The tools are divided into four sets. Different tools are visible, depending on the workspace mode **Express/Advanced** chosen.

**Selection Tools:**

The **Selection Brush** is used to highlight areas and details that need to be retouched. The transparency of lines made with the brush can be changed in the **Preferences** dialog. Press `B` to quickly access this tool.

If the **Keep Exclusion Area** is activated, the brush can not draw in excluded areas.

The **Exclusion Tool** is used to protect areas. Parts of the image marked by this tool will be excluded from the area used for calculation. You can use this tool to mark areas adjacent to a selection to prevent them from being cloned.

If the **Keep Selection** check box is activated, the tool can not draw in selected areas.

**Note:** The **Exclusion Tool** is available only in the **All-Purpose Retouching** mode.
The **Eraser** erases lines. Press **E** to quickly access this tool. The following modes can be selected:

- erase all lines;
- erase only selection area;
- erase only exclusion area.

The **Selection Bucket** fills an area outlined with the **Selection Brush** (useful for selecting large areas).

The **Magic Wand** selects all pixels of the same color. When the value of **Tolerance** is increased, more colors are included in the selected area.

If the **Contiguous Mode** check box is activated, only adjacent pixels of the same color are selected. If it is deactivated, all pixels the same color throughout the image will be selected. This tool is useful for selecting one color objects, text, etc.

**Manual Processing Tools:**

**Linear Retouch** allows you to restore the background in a specified direction: for example, to align the junction of areas or preserve the smooth edges of an object. Lines should be drawn as long as possible, into the red zone or across it.

**Parameters:**

**Gradient.** If this check-box is activated, areas between the beginning and the end of the line will be restored evenly, with a smooth transition between one part of the image and another. If this is not the result you want, deactivate the check box.
**Zone of Influence** affects the width of the area which is restored. The higher the value, the wider the restored area will be.

![Original Image](image1) ![Selection](image2) ![Result without Linear Retouch](image3) ![Zone of Influence = 2](image4) ![Zone of Influence = 8](image5) ![Result using Linear Retouch](image6)

**Search Distance** affects the size of the area from which fragments are taken, which are used to restore along a line. A large value increases processing time and may lead to the capture of unwanted fragments.

![Original Image](image7) ![Selection](image8) ![Search Distance = 1](image9) ![Search Distance = 5](image10)
Patch restores by copying similar square fragments from other parts of the image. To apply a patch, bring the cursor over the appropriate area, hold down the left mouse button, then drag the clone into the red area.

Parameters:

- **Patch Size** affects the size of the patch used in restoration.

Flip Horizontal. This option allows a fragment to be mirrored along the standing axis, i.e. interchanging the left and right sides.

Flip Vertical. This option mirrors a fragment by turning the image upside down.

Local Run is used to process selected areas of the image individually. Processing begins by clicking on a selected area. You can focus more clearly on individual selections, fine-tuning the parameters to restore each selection more effectively. Press L to quickly access this tool.

Post-Processing Tools (available for Home Deluxe and Business licenses):

Spot Remover removes small imperfections on an image: stains, dust, etc. You can also use it to retouch portraits, it looks like it "heals" skin problems. Just click with the tool on the defect. Press O to quickly access this tool.

History Brush lets you restore the image to its original state.

The tool's parameters:

- **Size.** The maximum width of a line made by the brush.

- **Hardness.** The blurriness of the tool's edges. The less the value the more blurry the tool's edges become. At value 100% the border between the brush's edges and the background is very distinct; at lower values the transition between these areas is smoother.

- **Strength.** The degree of restoration to the original state. At lower values there will be less restoration and more blending with the effect; at value 100% the original image will be restored more completely.
Clone Stamp copies parts of an image from one area to another while preserving the cloned area's original color palette, shadows, textures, lighting, and other characteristics. The hot-key for the tool is S.

Chameleon Brush copies parts of an image from one area to another, while taking into account the color palette, shadows, textures, lighting, and other characteristics of the background, onto which the clone is placed. Unlike the Clone Stamp, this tool preserves the texture of the image. The hot-key is H.

To duplicate an object, select an area to be cloned by holding down Alt on Windows or Option on Mac.

To remove a part of the clone, press the Ctrl-key on Windows / ⌘ on Mac, and keeping it pressed draw over the area.

Tools' options:

- **Size** - diameter of the brush.

- **Hardness** defines blurriness of the fragment's edges. At values near 100% the border between the fragment and the image is very distinct; at lower values the border between these areas will be smoother.

- **Opacity**. The opacity of the fragment in relation to the background. This parameter affects the opacity of the fragment where it is stamped: at lower values, the fragment is paler and its interaction with the background is greater.

- **Aligned** check-box. You can select the cloning method using the Aligned option. When the check-box is activated, a single clone will be created using information from around the selected source: in this case each time the left mouse button is pressed a clone will be selected from the relevant area. When the check-box is disabled, each time the mouse button is released the cursor returns to the source area, and new clone fragments are created from the same area.
It’s also possible to mirror a clone horizontally and/or vertically:

**Flip Horizontal.** This option allows a clone to be mirrored along the standing axis, i.e. interchanging the left and right sides.

**Flip Vertical.** This option mirrors a clone by turning the image upside down.
Mirror Image
Scaling. The size of the clone relative to the original fragment.

Additional Tools:

Crop (in the standalone version) lets you cut off unwanted areas in the image. The tool is useful when you want to improve the image composition, straighten a crooked photo, turn a horizontal photo into a vertical one and contrariwise. The tool settings are shown in the Settings Panel.

Change the crop area by dragging the sides and the angles of the bounding frame.

To apply the result and remove the areas outside the frame, press OK or use Enter. To cancel the operation and exit the tool, press Cancel or use the Esc-key. To restore the original area keeping the tool active, press Reset button.

Attention! It is recommended to crop the image before starting the actual processing. After applying the Crop tool, the selection disappears, and the History Brush ignores the previous state of the document.
At any stage of processing, you can revert the changes using  and .

Adjust the crop options:

You can choose the size of the crop rectangle from the **Ratio** drop-down list or enter your custom aspect ratio.

If the **External Area** check-box is enabled, you can change the color and opacity of the outer parts.

**Hand** lets you scroll the image when it does not fit within Image Window at the desired scale. To use it, click on the button, bring the cursor over the image, and while keeping the left mouse button pressed move in the desired direction.

Double-clicking on the tool's icon on the Toolbar makes the image fit the window.

**Zoom** lets you change the image's scale. To zoom in left click on the image. To zoom out left click with **Alt** on the image. The hot-key is **Z**.

Double-clicking on the tool's icon makes the image scale to 100% (actual size).
**IMAGE RESTORATION PARAMETERS**

**AKVIS Retoucher** is an efficient photo restoration program operating in 2 retouching modes.

For precise retouching of fine defects (scratches, spots, dust), use the **Small Defects** mode. If you need to remove large objects and quickly restore a photo, the **All-Purpose Retouching** mode is preferable.

**All-Purpose Retouching** Mode:

**Sample Size** (0-16) affects the size of sample fragments. At higher values of this parameter, more of the background's texture is preserved, but image detail appears coarser.

![Sample Size Examples](image1)

**Sample Number** (1–50) affects the number of sample fragments taken from surrounding areas and used in reconstruction. They are chosen randomly. At higher values, more of the background's texture is reconstructed, but processing time increases.

![Sample Number Examples](image2)
**Search Radius** (16-250) affects the size of the area used to search for sample fragments used in reconstruction. The higher the value, the longer reconstruction takes. If the radius is too large, sample fragments from remote areas of the image could be chosen, which would not be suitable in reconstruction.

**Smoothing** check-box. This mode reduces the transition between fragment edges. It's helpful if edges are similar in texture but not in color. If the check-box is deactivated there is no alignment.

**Fast Processing** check-box. When this check-box is activated, processing speed is increased by simplifying the original image. This is useful in most cases and allows you to quickly get a good result.
Small Defects Mode:

**Search Radius** (10-70). The parameter defines the search range of a fragment which will be used for the restoration. The higher the value, the longer the processing time.

**Comparison Radius** (2-20). The parameter specifies the size of the area used for the comparison of points.
**Variance** (1-25). The parameter sets the maximum allowable difference between the points.

**Color Correction** Group:

With the color correction settings, additional image processing is performed.

**Brightness** (-100..100). The parameter is used to change the image brightness. The higher is the value of the parameter, the lighter all pixels are, and vice versa.

**Contrast** (-100..100). The parameter is used to increase (if the value is over 0) or reduce (if the value is under 0) the difference between bright and dark parts of the image.
**Saturation** (-100..100). The parameter is used to change the intensity of colors.

**Sepia** check-box. Activate the check-box to apply the typical brownish shade of old photographs to your image.
The **Vignette** effect lets darkening or lightening the edges of a picture that helps to draw your eye to the central part. It's perfect for creating retro styled images, especially vintage looking portraits. The effect allows you to change a mood or enhance a composition of your image. Vignetting is fabulously easy to implement with AKVIS Retoucher.

**Attention!** The Vignette option is only available for Home Deluxe and Business licenses.

Adjust the parameters of the effect:

**Dark/Light Edges** (-100..100). The parameter sets the strength of darkening (at negative values) or lightening (at positive values) of the image edges.

**Size** (1-100). The parameter changes the effect area.
Shape (100..100). The parameter affects rounding of the edges and changes the central part of the image from a rectangle (at negatives values) to a circle (at positive values).

Smooth Transition (0-100). The parameter adjusts the smoothness of the border between the vignette and the central part. Increasing the value increases the fading effect.

Position. Move the white marker to shift the vignette. You can see the current coordinates of the center in the X and Y fields.
Moving Vignette
Open the **Preferences** dialog by pressing on 🛠. The dialog window looks like this:

- **Language.** To switch the interface language, select another language from the drop down list.
- **Interface Scale.** Choose the size of the interface elements. When it is set to **Auto**, the program workspace will automatically scale to fit the screen resolution.
- **Interface Theme.** Select the style of the program interface: **Light**, **Gray**, or **Dark**.
- **Initial Image Scale.** This option defines the way the image is scaled in the Image Window.
  - **Fit to View**: the image is completely visible in the window;
  - **100%**: the image doesn’t scale (generally, only a part of the image is visible).
- **Selection Area: Opacity.** The parameter allows you to adjust the opacity of the color used when a selection is created.
- **Recent Files** (available only in the standalone version). The number of recent documents. The list of the recent files, sorted by time, become visible by right mouse clicking on 📁. **Maximum**: 30 files.
- **Use OS File Dialog** check-box. You can check this option if you want to use the System Open/Save Dialog. By default, the AKVIS File Dialog is used.
- **Lock the Control Panel** check-box. It disables the possibility to hide/show the top panel. If the check-box is selected the panel is always visible. Uncheck the option to unlock the panel, and you will be able to hide/show it by clicking on the small triangle button (in the middle of the panel). The minimized panel will be shown when moving the cursor over it.

To apply changes made in the **Preferences** window press **OK**.

If necessary, you can return to the default settings by pressing **Default**.
AKVIS Retoucher supports **batch processing** that lets you automatically process a series of images. This feature is useful when retouching a lot of photos with similar defects or with the same date stamp.

It's possible to use batch processing in both (standalone and plugin) versions of AKVIS Retoucher, the steps are the same:

**Step 1.** Using the selection tools of AKVIS Retoucher mark the areas with the defects. These areas will be retouched in all photos in the selected folder.

Save the selection to a **.retouch** file by clicking on ![Image](AKVIS Retoucher Window with Marked Defects)

**Step 2.** Adjust the parameters. These settings will be applied to all photos in the folder.

**Step 3.** Click on the button ![Image](AKVIS Retoucher Window with Marked Defects) in the Control Panel to open the **Batch Processing** dialog window.

In the **Source Folder** field choose the folder which contains the photos to be processed.

In the **Target Folder** choose the folder where the processed photos will be saved. You can check **Include All Subfolders** to process all images in all subfolders of the selected folder (keeping the structure).

Choose a **.retouch** file with the selection.

In the **Save As** list specify the file format and quality level for the images.
Step 4. Press **Start** to begin batch processing of the photos.
In the standalone version of **AKVIS Retoucher** you can print the image. Press the button to open the **Print** options.

Adjust the parameters appearing in the Settings Panel:

Choose a printer from the list of available devices, set the desired resolution, as well as the number of copies to print.

In the **Orientation** group, set the position of paper: **Portrait** (vertically) or **Landscape** (horizontally).

Click the **Page Setup** button to open a dialog box to choose the size of the paper and its orientation, as well as the print margins.

Press the **Reset Margins** button to return the page margins to the default size.

Change the size of the printed image adjusting the parameters **Scale**, **Width**, **Height** and **Fit to Page**. These parameters have no effect on the image itself, just on the print version. You can change the size of the printed image by entering any value in %, or by entering new values in **Width** and **Height**.

To adjust the size of the image to the paper size, select **Fit to Page**.

Move the image on the page with the mouse or align it using the arrow buttons.

You can activate **Frame** for the image and adjust its width and color.

Choose the **Background Color** by clicking on the color plate.

In the **Page** tab, you can adjust printing of the multiple copies of the image on a single sheet.
Print Page

- **Copies per Page.** It lets you specify the number of copies of the image on one page.
- **Horizontally** and **Vertically.** These parameters indicate the number of rows and columns for the copies of the image on the page.
- **Spacing.** The parameter sets the margins between the copies of the image.

In the **Poster** tab, it’s possible to customize printing of the image on multiple pages for the subsequent junction into a large picture.

Print Poster

- **Pages.** If the check-box is enabled, you can specify the maximum number of the pages in which the image will be divided. The image scale will be adjusted to fit this number of the sheets. If the check-box is disabled, the program will automatically select the optimal number of the pages in accordance with the actual size of the image (scale = 100%).
- **Glue Margins.** If the check-box is enabled, you can adjust the width of the padding for bonding sheets. Margins will be added to the right and to the bottom of each part.
- **Lines of Cut.** Activate the check-box to display the cut marks in the margins.
- **Show Numbers.** With the enabled check-box, a sequence number of each part, by a column and a row, will be printed in the margins.

To print the image with the chosen parameters, press the **Print** button. To cancel and close the printing options click on **Cancel**.

Click the **Properties...** button to open a system dialog box that enables you to access the advanced settings and send the document to print.
AKVIS Retoucher offers two types of processing for photographs: retouching (eliminating defects and scratches) and removing objects. The sequence of actions involved in both cases is different: retouching is mainly performed through automatic processing, while when removing large objects, part of the work is done manually and requires learning how to use the Linear Retouch and Patch tools.

The following are general suggestions for removing a large object. At any stage you can undo changes with the buttons, make adjustments and then process the image again.

**Step 1.** Open the image in AKVIS Retoucher, and switch to Advanced mode.

**Step 2.** Select the object which you want to remove (along with any shadows or reflections).
Selecting the Object

**Step 3.** Use the **Linear Retouch** tool to restore the main lines of the background through the image.

Linear Retouch allows you to restore the background in a specified direction: for example, to align the junction of areas or preserve the smooth edges of an object. It is also useful for breaking a large object into smaller pieces, making it easier to remove.

**Direction of Lines**

Draw lines as long as possible, through the red zone and beyond it. Once a line is drawn, the fragments along it are immediately restored:
Step 4. Use the **Patch** to fill in the red zone with samples from the image which are the best suited for restoring the background.

Select a fragment for the patch  Place the fragment in the red zone  Result

Placing more patches in heterogeneous areas produces a better result, such as for an area covered in grass. Fewer samples would need to be placed in a homogeneous area, such as the sky.

It's better to use the **Linear Retouch** tool over the walkway, since it has a pronounced banded pattern.
Step 5. Use the Linear Retouch icon to connect all patches and divide the selection into homogeneous fragments. You can draw small lines through fragments.
Step 6. Use Local Run to restore individual fragments, starting with those at the edges of the object to be removed. Processing is started by clicking on a fragment. Parameters for each selection can be adjusted in the Settings Panel.

Why process the selection in fragments? When full processing (with the button) is applied, all of the fragments are processed at the same time. It's a long process in which samples are taken from areas adjacent to the selection, so they may not be best suited for properly restoring the entire selection. Therefore, areas processed in this manner will tend to appear rougher.

When you use the Local Run tool, samples are taken not only from the original background but also from newly restored areas adjacent to the fragment, allowing the background to be restored more gradually and accurately. Each fragment can be processed selection by selection. Therefore, the overall result depends on the order in which selections are processed.

If a fragment was processed unsuccesfully, press the button and readjust the settings (or add more patches). If it is difficult to find suitable parts of the background for patches, you can select from restored areas.
Adding Patches

This is the result after all areas have been processed.

After Using Local Run

**Step 7.** Perform post-processing on the image, to remove seams and other irregularities in restored areas. This can easily be done with the Clone Stamp [ ] and Chameleon Brush [ ] (which are available in the Home Deluxe and Business versions of the program).

If your version does not have these tools, you can select any remaining defects as done in previous steps and process the image again.

Now the figures have been removed from the picture.
Step 8. Save the resulting image.
RESTORATION OF AN OLD FAMILY PHOTO

Take a look at the old scanned photo and the result of restoration in AKVIS Retoucher.

This old photo is considerably damaged. We will restore this photo in two stages. At the first stage we will apply automatic processing in AKVIS Retoucher that will perform the preliminary work of removing most scratches and making big scratches less visible. At the second stage we will retouch the remaining defects with the post-processing retouching tools.

**Step 1.** Selection of the damaged area.

First of all, we should paint over all scratches and the inscription on the child's shoulder using the Selection Brush in AKVIS Retoucher.

We do not paint over the fold line that crosses the photo as it goes across the faces of the mother and child and it can be retouched better manually.

**Step 2.** Automatic restoration.

Press the button to start the photo restoration process. The program reconstructs selected parts of a photo by using information from surrounding areas.
Step 3. Retouching tools.

Now you can proceed to the second stage of restoration and retouch minor defects with the post-processing tools: **Clone Stamp** and **Chameleon Brush**. Both are available only in Home Deluxe and Business versions of Retoucher.

Alternatively, you can remove small defects using **AliveColors** which offers these and some other useful retouching tools.
AKVIS Retoucher is efficient for photo restoration tasks. It can be applied to restore old damaged photos or to remove a date stamp or an unwanted object, like a finger that covered the lens when shooting or an irrelevant object that spoils the shot.

This tutorial illustrates the second case: we will use AKVIS tools to remove the cage rods from the photo below.

**Step 1.** Open the image in **AKVIS Retoucher**. **Select** the bars using the **Selection Brush**. Don't forget to also select their shadows.

**Step 2.** After starting the retouching process by pressing the red area (along with the cage's bars) disappears. The image will appear like this:
Step 3. The joint at the bottom does not look correct. The image needs to be processed more accurately. Therefore, press \( \text{⬅️} \) to cancel the previous action. Switch to Advanced and choose the Linear Retouch tool. Draw a few strokes over places where you want to restore lines:

![AKVIS Retoucher interface](image)

Process the image by pressing \( \text{▶️} \).
Step 4. The processing result, of course, is not ideal: Retoucher failed to restore the nose, which was almost completely obscured by the cage's bars. We can use the Clone Stamp tool to deal with the incongruities of the fur.

The Clone Stamp repairs damaged areas using cloned fragments from other parts of the photo. Choose a cloning sample by left-clicking on a suitable area while holding Alt (Option in Mac). To apply the clone sample, bring the cursor over the area you want to repair and left click.

Look at this picture — the cage is gone, the lioness is free, and she even looks happier.
RESTORATION OF A DAGUERREOTYPE

The photo has been sent to us by Oleg Rakhimov. It is a daguerreotype of his relative made in 1893.

**Step 1.** Open the photograph in AKVIS Retoucher. We can say, that this daguerreotype was wisely preserved up to our times, so it will require very little retouching: just hiding a few scratches and "growing" the corners.

**Step 2.** Before the photo can be retouched, all of its damaged areas should be selected. First scale the image, so that it will be easier to see even the smallest scratches, and select them using the **Selection Brush**. Gradually paint over the scratches and missing areas of the picture.
Step 3. Press to begin the retouching process, and it will become apparent that the red highlighted areas disappear, along with the damage beneath them.

Here is the result, after the retouching process is complete.
AKVIS PROGRAMS

AKVIS Sketch Video — Convert Video to Cartoon
(Windows | Mac)

AKVIS Sketch Video is an After Effects and Premiere Pro plugin for converting videos into animated cartoons, both black and white and color. Apply cartoon effects easily with the Sketch Video plugin! More...

AKVIS AirBrush — Airbrushing Techniques on Your Photos
(Windows | Mac)

AKVIS AirBrush automatically transforms a photograph into a work of art which looks like made with a special airbrush tool that sprays paints or inks. The software works as an artistic filter creating stylish colorful airbrush designs from images using chosen settings of photo-to-painting conversion. More...

AKVIS ArtSuite — Frames and Effects for Your Photos
(Windows | Mac)

AKVIS ArtSuite is an impressive collection of versatile frames and effects for photos. ArtSuite contains many templates and texture samples that can be used to create a virtually limitless variety of options for generating frames. Decorate a photo to give it an original and festive look! More...
AKVIS ArtWork — Collection of Painting & Drawing Techniques

(Windows | Mac)

**AKVIS ArtWork** is photo to painting software designed to imitate different painting techniques - *Oil Painting*, *Watercolor*, *Gouache*, *Comics*, *Pen & Ink*, *Linocut*, *Pastel*. ArtWork helps you to create a piece of art out of any picture! [More...](#)

AKVIS Chameleon — Photo Collage Creation

(Windows | Mac)

**AKVIS Chameleon** is a fun to use tool for photo collage creation. It makes the process easy and entertaining.
The tool is very easy to handle as it does not require precise selection of objects. Using the software you can quickly create your own photo collages. More...

AKVIS Charcoal — Charcoal & Chalk Drawings
(Windows | Mac)

AKVIS Charcoal is a creative tool for conversion of photos into charcoal and chalk drawings. Using the program you can make professional-looking expressive black and white images. Playing with colors and options you can achieve outstanding artistic effects, such as sanguine and others. More...

AKVIS Coloriage — Add Color to Black and White Photos
(Windows | Mac)

AKVIS Coloriage allows colorizing B&W photos and replacing colors in color photos. Just indicate the desired colors by the stroke of the brush; the program does the rest of the work: recognizes the object’s border and tailors the new color to the grayscale tones of the initial picture. More...
AKVIS Decorator — Resurface and Recolor

(Windows | Mac)

**AKVIS Decorator** lets you change the surface of an object in a realistic manner. The program puts on a texture keeping the volume of an object, following its folds and creases. The new pattern looks absolutely natural and makes you see things differently. Recoloring is also made easy. More...

AKVIS Draw — Hand-made Pencil Drawing Effect

(Windows | Mac)

**AKVIS Draw** converts your photos into hand made pencil drawings. The software creates realistic looking line art illustrations, produces both B&W and color drawings. Add a hand-drawn look to your pictures! More...

AKVIS Enhancer — Bring Detail To Your Pictures

(Windows | Mac)

**AKVIS Enhancer** is image enhancement software that detects detail in underexposed, overexposed and mid tone
areas of a photo with uneven exposure. Enhancer improves every part of the image! The software works in three modes: Improve Detail, Prepress, and Tone Correction. The program offers a fast method to fix a dark photo, add contrast and brightness to a picture, it lets you improve color and adjust tones. More...

AKVIS Frames — Decorate Your Photos with Frames

(Windows | Mac)

AKVIS Frames is free software designed for working with the AKVIS frame packs. Using the program it’s easy to decorate your photos with exclusive picture frames! More...

AKVIS HDRFactory — High Dynamic Range Images: Brighter than Reality!

(Windows | Mac)

AKVIS HDRFactory lets you create a High Dynamic Range image from a series of shots or from one single photo. The program can also be used for photo correction. The program brings life and color to your photos! More...
AKVIS LightShop — Light and Star Effects

(Windows | Mac)

**AKVIS LightShop** lets you create an infinite number of astounding light effects! The program offers advanced lighting techniques for adding stars and glow effects to images. A light effect draws attention and brighten up any photo. Add a little magic to your pictures! More...

AKVIS Magnifier — Change Image Size without Quality Loss

(Windows | Mac)

**AKVIS Magnifier** helps to resize images without loss in quality. Whether creating poster-size images, adding resolution for printing an enlargement, or reducing image size, Magnifier will make your prints look sharper and better defined. More...
AKVIS MakeUp — Retouch Your Portrait Photos!
(Windows | Mac)

AKVIS MakeUp improves your portraits giving them a professional look. The software retouches facial imperfections making your skin radiant, beautiful, pure and even. The program adds glamour to your pictures and creates a high key effect. Look your best in every photo with AKVIS MakeUp! More...

AKVIS NatureArt — Bring Nature to Your Photos
(Windows | Mac)

AKVIS NatureArt is an excellent tool for imitating the magnificence of natural phenomena on your photos. Add dramatic nature effects to your photo, change the weather on it! With NatureArt you can become a wizard! More...
AKVIS Neon — Glowing Drawings from Photos
(Windows | Mac)

AKVIS Neon lets you create amazing glowing lines effects. The software transforms a photo into a neon image that looks like drawn with luminescent ink. More...

AKVIS Noise Buster — Digital Noise Reduction
(Windows | Mac)

AKVIS Noise Buster is software for noise suppression on digital and scanned images. Digital noise can be seen as artifacts and random red and blue pixels that compromise the smoothness of a photo. The program is efficient against both color and luminance noise. More...
AKVIS OilPaint — Oil Painting Effect

(Windows | Mac)

AKVIS OilPaint turns your photos into oil paintings. The mysterious production of a painting happens right before your eyes. The unique algorithm authentically reproduces the technique of the real brush. With this cutting-edge software you can become a painter! More...

AKVIS Pastel — Turn Photos into Pastel Paintings

(Windows | Mac)

AKVIS Pastel turns your photos into pastel paintings. The program converts your photo into a lifelike digital art imitating one of the most popular artistic techniques. AKVIS Pastel is a powerful tool to unleash your creativity! More...
AKVIS Points — Apply Pointillism Effect to Your Photos

AKVIS Points lets you transform your photos into paintings using one of the most exciting artistic techniques - pointillism. With the software you can easily create gorgeous works of art in a pointillist manner. Discover the world of bright colors! More...

AKVIS Refocus — Focus Improvement & Blur Effects

AKVIS Refocus improves sharpness of out of focus images. The program can process the entire photo or bring into focus only the selected part to make the subject stand out against the background. It's also possible to add bokeh and lens blur effects to your photos.

The software works in five modes: Refocus, Tilt-Shift, Iris Blur, Motion Blur, and Radial Blur. More...

AKVIS Retoucher — Image Restoration Software

AKVIS Retoucher is an efficient program for photo restoration and photo retouching. The software removes dust, scratches, stains, and other defects that appear on damaged photos. It intelligently reconstructs the missing parts of the photo using the information of the surrounding areas. More...
AKVIS Sketch — Convert a Photo to a Pencil Sketch

(Windows | Mac)

AKVIS Sketch converts digital photos to amazing pencil sketches and watercolor drawings. Now you do not need to handle a pencil to feel like an artist. All you need to create your original work of art is good taste and AKVIS Sketch. More...

AKVIS SmartMask — Save Time on Complex Selections!

(Windows | Mac)

AKVIS SmartMask is an efficient selection tool that saves time and is fun to use. Selection has never been so simple! The software considerably increases your productivity. You will be freed from boring work and will have
more room for creativity and realization of your ideas. More...

AKVIS Watercolor — Aquarelle Art from Photos
(Windows | Mac)

AKVIS Watercolor easily makes a photo look like a brilliant and vibrant watercolor painting. The software turns ordinary images into amazingly realistic aquarelle pieces of art. More...